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Descripción del ciclo de desarrollo de proceso 
El primer paso para desarrollar un archivo de proceso es crear un archivo de proceso. Después
de que se cree el archivo, se agregan los paneles de control. 

Los paneles de control son ventanas que usted utiliza para colocar otros objetos, tales como
interruptores, potenciómetros, y los gráficos de tendencias a ser mostrados. Usted puede
hacerlos parecer a los paneles de control físicos, completos con interruptores, botones, biseles,
inserciones, lámparas, instrumentos, etcétera. Su imaginación es el único límite a cómo se ven
y funcionan los paneles de control.

Después de que usted cree por lo menos un panel de control, usted puede después crear y
exhibir cualquier número de otros objetos. Recuerde que los objetos se pueden exhibir en un
solo panel de control o en paneles de control múltiples. Por ejemplo, usted puede inserir el
mismo interruptor en varios paneles. Si usted acciona el interruptor en un panel acciona
inmediatamente el interruptor en el resto de los paneles.

Los primeros objetos que desee crear podrían ser los que representan sus PLCs y RTUs
(Unidades  Terminales Remotas). Éstos tipos de clases de objetos utilizan a menudo sus puertos
de comunicación de la computadora, así que usted puede tener que configurar sus puertos para
la radio, el módem de discado manual, o una conexión hard-wired(Con cables) , como sea
adecuado. 

Vea el capítulo 3, Comunicaciones Seriales, en el Manual de Desarrollo de LookoutDirect para más
información sobre comunicaciones de configuración.

Cuando usted crea un objeto que represente un PLC, una RTU, u otro aparato de entradas y
salidas, su funcionalidad y base de datos asociadas son parte del objeto. La funcionalidad
construida en este tipo de clase de objetos incluye un driver del protocolo, permitiendo al
objeto comunicarse con el aparato físico. La base de datos nativa (por defecto) incluye todos los
registros, bits, señales de entradas y salidas, parámetros y otros valores a los cuales el aparato
físico pueda transmitir o recibir LookoutDirect.

En este punto, usted puede querer agregar a miembros de datos a las bases de datos nativas para
sus objetos. Tales nuevos miembros de datos, llamados los aliases, pueden incluir nombres
descriptivos, parámetros de escala de la señal, parámetros de alarmas, etcétera. Usted puede crear
más de un alias para un miembro nativo dado de datos, usando diversos parámetros de escala o
de alarmas para cada uno.

Mientras crea objetos, usted puede conectarlos con otros objetos. El tipo de objetos que usted
crea (por ejemplo un potenciómetro, un interruptor, Madcaps, tendencia, etcétera) y la manera
como usted los conecta determina cómo su sistema interactúa con su proceso.
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Muchas clases de objetos que usted usa se aprovechan de servicios de LookoutDirect. Por
ejemplo, usted puede asignar un nivel de seguridad a un objeto potenciómetro y la clase de
objetos de alarmas utiliza el subsistema del proceso de alarmas. Mientras usted crea los objetos
que se aprovechan de estos servicios, usted debe configurar  los servicios específicamente para los
requisitos de la aplicación.

Sugerencia  Usted puede salvar un archivo de proceso con cualquier nombre que usted elija. El nombre del
archivo de proceso escojido por Ud no tiene que ser idéntico a su nombre de proceso. Usted puede copiar
(o Save as) archivos LookoutDirect para colocar un nombre  nuevo y hacer funcionar el proceso de la misma
forma que hace funcionar los archivos originales. Usted no puede, sin embargo, hacer funcionar dos
procesos con el mismo nombre de proceso en una sola instancia de LookoutDirect. Si usted tiene un proceso
básico que usted necesite hacer varias variaciones, usted puede colocar un nuevo nombre al proceso en cada
archivo haciendo clic en el botón derecho en el nombre de proceso en el explorador de objetos LookoutDirect
y seleccionando Rename.

Creando Procesos servidor y cliente 
Según lo explicado en la sección de procesos de cliente y de servidor del capítulo 2, Cómo trabaja
LookoutDirect, los procesos del servidor LookoutDirect funcionan en las computadoras con
conexiones físicas a su hardware. Los clientes LookoutDirect funcionan con computadoras que
pueden comunicarse con computadoras que tienen funcionando los servidores LookoutDirect.
Usted construye estos clientes y servidores eligiendo objetos y haciendo conexiones.

Navegación en LookoutDirect
Muchas cajas de diálogo en LookoutDirect que usted usa para crear un objeto, mostrar una
expresión, hacer una conexión, y así sucesivamente, contienen una cierta variación del cuadro
de diálogo siguiente. Este cuadro de diálogo se usa para localizar cualquier objeto en cualquier
proceso LookoutDirect que funciona en su red.

Cada computadora registrada con LookoutDirect
funcionando en ella aparece en este cuadro de
diálogo. El hacer clic en la computadora para abrir
la exhibición completa muestra los procesos que
funcionan corrientemente en esa computadora. El
hacer clic en un proceso particular muestra todos
los objetos en ese proceso a los que usted pueda
tener acceso.

La caja en la parte superior de tales exhibiciones
indica la localización  de la raíz. Para exhibir todas
las computadoras registradas como funcionando
con LookoutDirect y también como exhibiendo su
propia computadora como local, usted configura
Universe como raíz. Usted puede configurar su
computadora local, la red de las computadoras registradas con LookoutDirect, cualquier
computadora específica en la red, o cualquier proceso como la raíz haciendo clic en el botón
derecho en ese nodo y seleccionando Make Root (haga la raíz).
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Nota:  LookoutDirect no puede corregir o editar  procesos a través de la red, de modo que lo que usted puede
hacer con  computadoras y  procesos que funcionan en una red es limitado. Para modificar un proceso, usted
debe estar en el nodo local de la red; es decir, la computadora  local (o de un proceso que funciona en él).

Usted puede distinguir entre una representación local o de red de su computadora en
LookoutDirect en la ventana de la selección de la raíz viendo el icono de la computadora. 

La representación de la red de su nombre de computadora tiene flechas rojas representando la
conexión de la red de E/S, según lo mostrado a la derecha en la ilustración siguiente.La
representación local, a la izquierda, no tiene ninguna flecha de E/S.

Vea el capítulo 4, Creación de una red, en el Manual de Desarrollo de LookoutDirect para más
información sobre la configuración de las computadoras y la navegación con procesos
LookoutDirect en su red.
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Creando Un Proceso en LookoutDirect
Lo que sigue explica el procedimiento básico para crear un archivo de proceso nuevo.

1. Seleccione File>New.

Aparece el cuadro de diálogo Create Process.

2. Teclee un nombre de proceso de LookoutDirect en el campo Process Name. Este  nombre
debe seguir a las mismas convenciones que un nombre de objetos de LookoutDirect. Vea la
sección de nombres de objetos para más información detallada sobre convenciones de
nombramiento LookoutDirect.

3. Haga las selecciones en el grupo State Information. Cada control se explica abajo.

Nota  si usted va a tener una computadora de respaldo en la red que esté en línea y haga funcionar este
proceso en caso que su computadora primaria falle, usted debe incluir una localización en esa computadora
como un lugar para salvar el archivo de estado de proceso. 
Vea el capítulo 10, Redundancia, del Manual de Desarrollo de LookoutDirect para más información sobre las
computadoras de respaldo y los procesos de  creación.

Seleccione Save State file with Process File (Salve el archivo del estado con el archivo de
proceso)  para salvar el archivo del estado en la localización en donde fue abierto el archivo
de proceso. Éste es el comportamiento por defecto.
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Seleccione  Save Standby State file para salvar una o mas copias del archivo de estado en la
carpeta de LookoutDirect su están funcionando actualmente. El nombre del archivo del
estado será igual que el nombre de proceso.Esto es útil si las computadoras múltiples están
compartiendo un archivo de proceso. En este caso, cada computadora mantiene su propio
archivo de estado localmente.

Seleccione la caja de verificación Save Standby State file para salvar unas o más copias
adicionales del archivo del estado en una localización de su escoja. Teclee una trayectoria
completa, incluyendo el nombre del archivo del estado, para cada localización que desea
salvar un archivo de estado. Si usted está salvando el archivo de estado a más de una
localización alternativa o de respaldo, separe las trayectorias con el símbolo barra vertical (|).

Para configurar la frecuencia que LookoutDirect salva el archivo de estado, marque la caja de
verificación  Save State file every y llene un valor para el número de minutos que usted desea
pasar entre cada almacenamiento. Recuerde que el salvar archivos usa  recursos del sistema ,
de modo que si usted tiene una cantidad de procesos, cada  uno o más salvando el archivo de
estado  a menudo, usted puede experimentar algunos problemas de funcionamiento.

4. Haga la selección en el grupo Citadel Database (base de datos del citadle). Cada control se
explica abajo.

Si usted marca la caja de verificación Use default Values (Use valores originales de fábrica),
LookoutDirect usa la localización por defecto configurada en el cuadro de diálogo System
Options en cualquier instancia de LookoutDirect.

Si usted entra en un nombre de computadora y una trayectoria en esa computadora a una
carpeta específica, LookoutDirect registra datos a esa localización en esa computadora, no
importa cual  computadora está haciendo funcionar el proceso.

Para señalar una computadora y una trayectoria específicas para su proceso a los datos de
registro, inscriba el nombre completamente cualificado de la red para la computadora blanco
en el campo Citadel database Computername (Nombre de comoutadora de base de datos
Citadel), y la trayectoria completa al directorio de la base de datos del blanco en el campo
Citadel database folder (carpeta de la base de datos Citadel).

Nota:  Las configuraciones de State Information (información del estado) y de Citadel database (base
de datos Citadel) que usted hace cuando crea un proceso invalida cualquier configuracion que se  pudo
haber hecho en el cuadro de diálogo de System Options (opciones del sistema).
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Creando objetos

Escogiendo Objetos
¿Cómo usted decide qué objetos usa y qué conexiones hace?

Algunas decisiones son fáciles; usted usará seguramente objetos driver para diferentes PLCs, RTUs
y otros aparatos que usted necesita supervisar y controlar. Otras decisiones son hechas por lo que
usted desea hacer.

Para solucionar problemas con LookoutDirect pregúntese qué objeto hace lo que usted necesita
hacer.
LookoutDirect tiene muchas clases de objetos con aplicaciones obvias, tales como botones,
interruptores y exhibiciones de gráficos de tendencia. Otras clases de objetos de LookoutDirect
pueden no ser inmediatamente obvias en cómo pueden ser que sean usadas. Para familiarizarse con
las clases de objetos de LookoutDirect, usted puede mirar la ayuda en linea de la Referencia de
Objetos de LookoutDirect, o del Manual de Referencia de Objetos de LookoutDirect que fue instalado
junto con LookoutDirect.

El cuadro de diálogo Select Object Classes que aparece cuando usted crea un nuevo objeto tiene
descripciones cortas de cada clase de objetos. Leyendo y estudiando estas descripciones es otra buena
manera de conocer las funciones de LookoutDirect. Usted puede encontrar una lista de estas
descripciones en el Apéndice A, Descripciones de objetos de LookoutDirect.

Después de que se haga familiar con las clases de objetos de LookoutDirect, usted tendrá una mejor
idea  de qué objeto crear o que clases de objetos puede investigar, para solucionar el problema que
usted está enfrentando en ese momento.

Creando un objeto
Complete los pasos siguientes para crear un objeto de LookoutDirect.

1. Abra o cree un nuevo proceso, si uno no está ya abierto, en LookoutDirect. Cerciórese de que
usted  esté en el  modo Edit. (seleccione  Edit>Edit  Mode o apriete < Ctrl-Shift > en
caso de necesidad.)

2. Hay dos maneras de crear nuevos objetos en LookoutDirect:
• Seleccione Object>Object Explorer desde el menú para activar al explorador de objetos

LookoutDirect. Haga clic en el botón derecho en el proceso que usted desea crear un
objeto y seleccione New Object (nuevo objeto). Para este ejemplo, seleccione la clase de
objetos potenciómetro, encontrado en la categoría de control.

• Seleccione el comando  Object>Create de la barra de menú de LookoutDirect. Para este
ejemplo, seleccione la clase de objetos potenciómetro, encontrado en la categoría de
Control .
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3. Aparece el cuadro de diálogo Select Object Class, según lo mostrado en la figura siguiente.

Figura 5-1. Cuadro de diálogo Select Object Class

La primera vez que usted crea un objeto en LookoutDirect, aparece el cuadro de diálogo Select
Object Class con la opción Categorize marcada. Algunas clases de objetos están contenidos en
más de una categoría, dependiendo de su versatilidad.

Si una categoría está abierta, usted puede saltar a la clase de objetos que usted desea teclando las
primeras letras. Para tener acceso a todas las clases de objetos con esta técnica, inhabilite la
opción Categorize haciendo clic para remover la marca en la caja de verificación de Categorize.
Cuando usted selecciona una clase de objetos, aparece un cuadro de diálogo que usted usa para
definir los parámetros para un objeto específico, según lo mostrado en el ejemplo siguiente para
crear un objeto  potenciómetro .

Figura 5-2.  Cuadro de diálogo de definición de Objetos 
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4. Asigne un nombre único al objeto. Nombres válidos se describen en la sección siguiente,
nombres de objetos.

5. Defina los parámetros del objeto. Cada clase de objetos tiene parámetros únicos, descritos en
el archivo de ayuda de LookoutDirect o el Manual de Referencia de Objetos de LookoutDirect.

Los parámetros ordinarios que se pueden configurar solamente en el cuadro de diálogo de la
definición de objetos son indicados por campos blancos.

Algunos parámetros, sin embargo, son expresiones, denotadas por un campo amarillo. Las
expresiones le dejaron configurar un valor de parámetro por programa conectando el
parámetro con un miembro de datos de otro objeto. Usted puede también manipular datos
usando las funciones de expresión, que son aproximadamente el equivalente de fórmulas de
una hoja de cálculo. 

Vea la sección de los objetos que conecta de este capítulo para una explicación básica de cómo
usar expresiones, y el capítulo 2, Expresiones, del Manual de Desarrollo de LookoutDirect para
más información detallada sobre expresiones y las funciones de expresión. El ejercicio de
enseñanza en el capítulo 3, como comenzar con LookoutDirect, también muestra expresiones.

6. Deje Position source (fuente de estado) configurada como local.

La fuente de estado determina qué valor toma el control cuando su proceso se abre, y también
afecta  la manera que el control funciona.

Seleccionando como Local configura su control para tomar su valor del archivo de estado
cuando el proceso se abre. El valor de control no cambiará a menos que usted lo configure
manualmente o en el programa con una conexión directa al miembro de datos  del valor  de
control.

Seleccionando Remote configura su control para tomar su valor inicial de un miembro de
datos de de lectura/escritura de un otro objeto de LookoutDirect. Para lograr esto usted entra
un URL al miembro de datos, dondequiera que su proceso de anfitrión pueda estar
funcionando. Esta conexión es recíproca; ajustando el control cambia el valor del miembro de
datos, y cualquier cambio en el miembro de datos por alguna causa ajusta el valor del control. 

Vea la sección Conexiones de fuentes de posición remotas de este capítulo para más información
sobre controles remotos.

Nota: La fuente de estado remota ha cambiado en LookoutDirect 4.0.Si usted está acostumbrado a desarrollar
procesos en versiones anteriores de LookoutDirect, cerciórese de leer la sección de las conexiones de fuente
de estado remotas de este capítulo para entender los cambios y hacer el mejor uso de esta característica.

Usted puede seleccionar DDE como su fuente de estado si usted desea usar redes  con DDE o
si usted necesita conectar su control con una aplicación deferente de LookoutDirect, por
ejemplo Microsoft EXCEL. 

Vea el capítulo 5, Intercambio Dinámico de Datos, del Manual de Desarrollo de LookoutDirect
para más información sobre el uso de esta característica.
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Redes que usan DDE fueron utilizadas en versiones anteriores a LookoutDirect 4.0. En general, la
creación de una red TCP/IP construída en LookoutDirect 4.0 y mas nuevo es más eficiente y más
fácil que la creación de una red con DDE. 

Si usted está manteniendo un proceso de un LookoutDirect antiguo, o tiene una cierta necesidad
especial de utilizar una red con DDE, usted puede encontrar más información detallada sobre esta
función en el apéndice A, Establecimiento de una red con DDE, del Manual de Desarrollo de
LookoutDirect.

7. Seleccione OK para crear el nuevo objeto.

Muchas clases de objetos no tienen componentes (con excepción de un valor del miembro de datos)
que usted pueda exhibir en un panel de control, tal como un driver de protocolo para un PLC
típico, o una clase de objetos tal como Neutralzone o pulso (ambas clases de objetos de
LookoutDirect con funciones especiales).

Algunos objetos, como los potenciómetros, se pueden exhibir en un panel de control. Cuando
usted crea tal objeto, LookoutDirect le presenta un cuadro de diálogo que usted usa para definir
cómo el objeto se muestra en el panel actualmente activo (si hay uno).

8. Si usted creó su objeto usando al explorador de objetos de LookoutDirect, aparecerá en la ventana
del explorador de objetos pero no en cualquier panel de control. Para exhibir el potenciómetro,
usted tendrá que arrastrarlo y soltarlo en el panel de control en que se quiere que aparezca. Si usted
creó su objeto usando el menú, el cuadro de diálogo de las propiedades de exhibición aparece al
hacer clic en OK para acabar de definir el objeto.

Figura 5-3. Cuadro de diálogo de Exhibición del Potenciómetro  
9.  En el cuadro de diálogo de exhibición, elija cómo usted quiere que el objeto sea representado

y selecciónelo y luego haga clic en  OK.
10.Coloque el objeto en el panel de control y configuración el tamaño.

Nota: Usted puede copiar objetos para pegar sobre otro panel de LookoutDirect en el mismo proceso, pero
si los paneles son de tamaños diferentes, los objetos pegados pueden no aparecer en la localización
apropiada en el panel nuevo. En general es más fácil arrastrar el objeto al panel nuevo del explorador de
objetos de LookoutDirect.

Accionador Horizontal



Nombres de Objetos 
Un nombre de objeto sirve para identificar un objeto específico. Usted debe asignar a cada
objeto un nombre único. LookoutDirect no permite que usted cree o que modifique un objeto
si el nombre no es único o si no sigue las convenciones de nombres.

Las reglas para escojer los nombres  son como sigue:

• Los nombres pueden incluir los caracteres A - Z, a - z, 0 - 9, y el carácter de subrayar (_).

• Los nombres deben comenzar con una letra.

• Los nombres pueden tener hasta 32 caracteres

• No se permiten espacios y tabs

•     LookoutDirect reconoce caracteres mayúsculos y minúsculos  como el mismo carácter, así que  SW2
y  sw2  son el mismo nombre.

• Los nombres no deben ser palabras claves de LookoutDirect (los nombres de la clase de
objetos y los nombres de funciones). Por ejemplo, usted no debe utilizar términos tales
como Switch, delayOn, STDEV, Modbus, nif, y Trend. Usted puede, sin
embargo, utilizar Switch1, Switch2, etcétera.

A continuación ejemplos de nombres válidos:

• Pump3_HOA 
• HighServicePump3_Run
• Nivelpozo11_en__Limar?
• HighServicePump3_Run

• Pushbutton1
A continuación algunos ejemplos  de nombres  inválidos:

·
  

3Pump_HOA, que comienza con un número 

·
  

_ HighServicePump3_Run, que comienza con una raya 

·
  

Nivelpozo11 en Limari , que contiene espacios 

·
  

# ShaftTempF, que comienza con # 

·
  

Pushbutton, que es una palabra reservada 

·
  

Estenombretienemasdetreintaydoscaracteres, que es demasiado largo 

·
  

and , que es una palabra reservada 

Manual de cómo comenzar LookOutDirect 5–11

Capítulo 5: Usando LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D



Conectando Objetos
En LookoutDirect usted conecta objetos para pasar señales de control  entre objetos.Una vez que
estén conectados, los objetos pasan señales entre sus varios miembros de datos y parámetros.

Hay un gran cantidad de clases diferentes de conexiones en LookoutDirect y diversas maneras
de hacer esas conexiones. El método que usted utiliza depende de lo que usted está tratando de
hacer.

·
  

Usted puede conectar a un miembro de datos con otro. 

·
  

Usted puede conectar un miembro de datos con un parámetro de objeto, o un parámetro
de objeto con un miembro de datos. 

·
  

Finalmente, usted puede hacer una conexión de URL como una fuente remota de posición
para un control LookoutDirect o una conexion simbólica, o como artículo de rastreo para
un objeto HyperTrend.

Usted puede hacer estas conexiones de LookoutDirect de las siguientes maneras:

·
  

Directas- Hecho con el cuadro de diálogo Edit Connections, estas conexiones son fijas y
trabajan en una dirección solamente. Esta clase de conexión se debe hacer solamente de un
proceso del servidor al hardware instalado en la computadora de servidor, o entre los
objetos contenidos dentro del mismo proceso.

·
  

Remotas-Un conexión remota de URL es un tipo flexible de conexión completamente
recíproca entre un control de LookoutDirect y un miembro de  datos de lectura/escritura
de objetos. Cambiando el control cambia el miembro de datos, como usted esperaría, pero
si el valor de ése miembro de datos cambia por alguna otra causa, el valor de control
cambia también. Esta clase de conexión es lo que usted usa para conectar un proceso de
cliente con uno del servidor, o para unir dos procesos de cliente  a través de un servidor.

·
  

Complejas-usted puede hacer conexiones complejas usando variables y pruebas lógicas
para responder dinámicamente a necesidades y a circunstancias cambiantes. Las conexiones
complejas pueden aplicar operaciones matemáticas a los datos, procesándolas para usos por
otro objeto. Usted puede hacer conexiones complejas directas, y con el objeto de
conexiones simbólicas de LookoutDirect, hacer también conexiones complejas remotas.

Sugerencia Recuerde, cuando usted elige un objeto en el cuadro de diálogo Edit  Connections,
seleccione siempre el objeto al que usted desea conectar.
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Conectando miembros de datos a parámetros
El ejemplo siguiente utiliza a miembro (implícito) de datos de un objeto potenciómetro  como
la fuente de datos de un objeto Average (promedio) para ilustrar el tipo más simple de conexión
deLookoutDirect. Usted puede decir que Data (datos) sea un parámetro porque aparece en el
cuadro de diálogo del objeto Average.

Suponga que usted crea un objeto potenciómetro según lo mostrado en la ilustración siguiente.

Usted puede ser que cree después un objeto
Average. 

Conecte la señal numérica del potenciómetro con el
parámetro Data (datos) entrando Po

t1

como el
parámetro de datos del objeto Average.  

El objeto Average calcula el nivel promedio de Pot1
en un cierto período, según lo descrito en la
definición del objeto en la ayuda de LookoutDirect
o el Manual de Referencia de objetos de
LookoutDirect.

Éste es el caso más simple para hacer una conexión directa en LookoutDirect; conecte la entrada
de un objeto con la salida de otro objeto en el mismo proceso. En muchos casos usted tendrá
que conectar objetos en un proceso con los objetos en otro proceso en la misma computadora,
o en otra computadora en la red. Para estas conexiones usted puede hallar más conveniente usar
el redactor de expresión, a que usted tiene acceso haciendo clic en el botón derecho en el campo
amarillo de la expresión. 

Los ejemplos en el capítulo 3, Como comenzar con LookoutDirect, le guían en como hacer
conexiones detalladamente.
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Identificando a miembros de datos de Objetos
Ya que muchos objetos generan señales múltiples que usted puede usar como entradas a otros
objetos, el nombre del objeto no es siempre suficiente para identificar la señal deseada. Usted
debe identificar al nombre del objeto y al miembro apropiado de datos. Por ejemplo, un objeto
Modbus genera millares de señales, algúnas lógicas y algúnas numéricas. Para especificar
exactamente que señal desea desde un objeto particular Modbus, teclee el nombre del objeto
seguido por un punto (.) y el miembro de datos que usted desea.

Si usted tiene un objeto Modbus con un nombre  PL
C1

,  y usted desea exhibir el valor que reside
en llevar a cabo el registro 40001 y el estado de la bobina 100, refiérase a esos miembros
particulares de datos por PLC1.40001 tecleando en una expresión y PLC1.100 en otra
expresión.

Conectando miembros de datos a miembros de datos
La información siguiente es una extensión del ejemplo anterior, en el cual usted creó un
potenciómetro nombrado  Po

t1

. En este ejemplo, usted crea un objeto Modbus y conecta la
señal numérica generada por el potenciómetro  con un holding register de 16 bits en la dirección
40001 en el PLC.
1. Cree un objeto Modbus. Usted no tiene que tener un PLC real conectado con su sistema.

Solamente acepte las configuraciones del parámetro por defecto en la caja de diálogo de
Modbus y haga clic en OK.

2. Si su explorador de objetos está abierto, haga clic en el botón derecho en el objeto Modbus
que usted acaba de crear y seleccione  Edit Connections del menú pop-up. Si no,  seleccione
Object>Edit Connections desde la barra de
menú de LookoutDirect. Usted utiliza el
cuadro de diálogo Edit Connections cada vez
que esté conectandose con la base de datos de
otro objeto.

3. Si usa el comando de menú Object>Edit
Connections, aparece la caja de lista de Edit
Object Connections. Elija el objeto que
contiene el miembro de datos al que usted se
está conectando.

El campo Current location (localización
corriente) en la parte superior de este cuadro de
diálogo debe mostrar su computadora como raíz.
Vea la sección de navegación de LookoutDirect
para más información sobre cómo configurar la
raíz en un cuadro de diálogo de LookoutDirect.
Porque usted está conectando  la señal  Pot1  con
el miembro de datos 40001 en el objeto Modbus,
seleccione  el objeto Modbus1 y haga clic en OK.
Aparece el cuadro de diálogo Edit Connections.
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La parte superior de este cuadro de diálogo contiene la información sobre el objeto al que
usted se está conectando .Usted selecciona un miembro escribible de datos  de ésos
enumerados en la lista Writable members (miembros escribibles), y el miembro seleccionado
aparece a la izquierda del campo amarillo de expresión en el centro del cuadro de diálogo.

La parte más inferior del cuadro de diálogo le deja navegar al miembro de datos que usted
desea conectarse con el miembro de datos que Ud selecciona en la porción superior de la caja.
Usted puede también entrar a un miembro de datos directamente en el campo amarillo de la
expresión.

4. Teclee el miembro de datos al que usted desea conectarse en la caja de lista a la derecha del
botón Select. Usted puede teclear en miembro de datos que usted desea directamente, o usted
puede elegirlo en la lista de miembros escribibles y haciendo clic en el miembro de datos (o
el rango de los miembros de datos) que usted desea. Usted puede corregir el número que
aparece en la caja de selección.

Haga clic en  el botón Select para identificar al miembro de datos al que se escribirá. Note
que el cuadro de diálogo ahora refleja un miembro específico;  Modbus1.40001 =. También
note el signo igual (=) . Esto le pide conectar una expresión con Modbus1.40001.  En este
caso, utilice la expresión  Pot1.

5. Dentro de la sección de Signals (señales) del cuadro de diálogo, configure su computadora
local como la raíz en el campo In. Navegue a Pot1 y selecciónelo haciendo clic en él. Haga
clic en  un miembro (implícito ) de  datos en la lista  Contents (readable) y después haga clic
en el botón Paste.
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Note que el tipo de datos de los miembros de datos que usted ha seleccionado está mostrado
para ayudarle a cerciorarse de está conectando como tipo con un tipo semejante. Note
también que usted puede corregir fácilmente conexiones existentes  haciendo clic en la lista
en el campo Existig Connections.

Nota:  Exactamente sobre la lista Contents (readable) en las sección señales, usted notará una caja de lista
nombrada Path Mode. Esto es un configuración importante para desarrollar procesos de red en
LookoutDirect. Vea los nombres de la trayectoria en la sección de LookoutDirect para una información más
detallada sobre cómo utilizar esta característica. Se muestra el uso de diversas configuraciones de la
trayectoria en los ejercicios contenidos en el capítulo 3, como comenzar con LookoutDirect.

6. Haga clic en el botón Accept. Esto confirma la conexión. Usted debe ver un mensaje
confirmando la acción. Usted también verá el miembro  de datos 40001 agregado a la caja de
lista en el campo Existing Connections.

Usted ahora ha conectado un miembro de datos de un objeto con un miembro de datos de otro
objeto. Cualquier cambio en el valor (implícito)  de Pot1 es, por definición, un evento,
enviando una señal al resto de objetos al que  Pot1 está conectado. Ya que ahora está
conectado con  Modbus1.40001, la configuración  de Pot1 cambia el valor del miembro de
datos  40001 en el objeto  Modbus1.
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Conexiones de URL
Una conexión de URL (localizador universal de recursos) es distinta de una conexión hecha con una expresión
porque no puede contener ninguna condición de verificación u operaciones matemáticas. También está
diseñada para permitir un flujo recíproco de datos a través de la conexión. Un control conectado con un
registro del PLC usando una conexión de URL cambia el valor del registro cuando se ajusta. Pero si el valor
del registro cambia por alguna otra causa, el control también cambiará para igualar al valor corriente del
registro.

Usted puede hacer solamente una conexión de URL a los miembros de datos  que  son escribibles, o legibles
y escribibles. Usted no debe hacer una conexión de URL a un miembro de datos inalterable. Las conexiones
remotas de la fuente de estado, las conexiones simbólicas, y el objeto HyperTrend requieren conexiones de
URL, según lo indicado por
un campo verde.

Usted puede corregir un
URL haciendo clic en el
botón derecho en el campo
verde, que abre el cuadro de
diálogo del redactor de URL
de LookoutDirect, mostrado
en la figura adyacente.

Usted puede utilizar la lista
del árbol en la ventana
izquierda para localizar el
objeto que usted desea, y
seleccionar un miembro de
datos en la ventana derecha.
Haga clic en el botón Paste
para insertar la secuencia
completa en l campo de
URL.

Usted controla la relatividad
de la trayectoria de su URL con la caja de la selección Path Mode (modo de la trayectoria). 

Vea el capítulo 4, nombres de la trayectoria en la sección de LookoutDirect para más información sobre como
usar la selección de modo de la trayectoria.

Conexiones remotas de la fuente de estado
La conexión remota de la fuente de estado es el método preferido para conectar un control en
un proceso en una comoputadora cliente con un proceso en el servidor en LookoutDirect.

Ya que normalmente  usted desea poder tener procesos del cliente trabajando desde cualquier
computadora en su red sin tener que modificarlas, lo mejor es hacer conexiones de procesos del
cliente a los procesos del servidor, y no de los servidores a los clientes. Ya  que los procesos del
servidor necesitan funcionar generalmente de la misma computadora a cada instante, usted
puede utilizar trajectorias absolutas para cerciorarse de que sus procesos  en el cliente se
conectarán con los procesos en el servidor, no importa dónde estén funcionando los clientes.
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Conexiones de Conexión Simbólicas
Los objetos de conexion simbólica (Symbolic Link) tienen varias aplicaciones importantes en
LookoutDirect. Es la mejor forma de conectar un cliente a un servidor, son necesarias para
implementar redundancia y para usarlas en conjunto con links dinámicos para conectar
expresiones complejas  

La figura siguiente muestra el cuadro de diálogo Create Symbolic Link (crear conexión
simbólica.

Usted puede hacer una conexión de URL en el campo de la fuente Static a un proceso entero
con una conexion simbólica y después tener acceso a cualquier objeto en ese proceso con la
conexión. Ésta es una parte crucial de la redundancia  de LookoutDirect, que se describe en el
capítulo 10, Redundancia, del Manual de Desarrollo de LookoutDirect.

Usted puede incorporar una expresión compleja en el campo Dynamic de la fuente de conexión
simbólica y después hacer una conexión de URL a la conexión simbólica a sí misma, evitando la
restricción en expresiones complejas en las conexiones alejadas de la fuente de estado para  controles.

Conexiones de elementos Hypertrend
Vada elemento que se muestra en el registrador gráfico hypertrend tiene acceso a trvés de una
conexión URL , ya que los datos de hypertrend vieien desde la base de datos Citadel.

Si usted necesita colocar una expresión compleja en un registrador grafico, usted puede crear
una expresión nombrada creando un objeto (expresión). Usted puede incorporar la expresión
compleja que usted desea graficar, la registra a la base de datos histórica, y después la muestra
como artículo de HyperTrend.

Nota  Si usted convierte un proceso creado en una versión anterior a LookoutDirect 4.0, LookoutDirect
crea y registra automáticamente una expresión nombrada para que su  objeto de HyperTrend exhiba
cuando él  recompile  el archivo fuente .lks.

Ejemplo de link simbolico
Nombre

Fuente

Estático

Dinámico



Mostrando miembros de datos en paneles de control 
Siga estos pasos para exhibir a un miembro de datos en un panel de control:

1. Cerciórese de que LookoutDirect esté en modo Edit y abra el explorador de objetos
seleccionando  Object>Object Explorer.

2. Navegue al  objeto o al miembro de datos del objeto que usted desea exhibir en su panel. En
la figura siguiente, se ha seleccionado a un miembro de datos de un objeto de forma de onda
que funciona en un proceso de servidor situado en otra computadora en la red.

3. Arrastre y suelte el miembro de datos sobre el panel que usted quiere que los datos sean
mostrados. LookoutDirect coloca una expresión para exhibir los datos. Usted  puede tener
que ajustar el tamaño de la exhibición para que los datos aparezcan correctamente.

4. Haga clic en el botón derecho en la exhibición para cambiar sus características de exhibición,
para modificar la expresión, para cambiar el formato de datos, o para alterar cualquier otra
característica de exhibición.

Usted puede también insertar una expresión a los datos de exhibición eligiendo
Insert>Expression de la barra de menú LookoutDirect. Aparece el cuadro de diálogo Insert
Expression según lo mostrado en la figura siguiente.
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5. Navegue al miembro de datos que usted desea exhibir, como usted hizo con el explorador de
objetos.

6. Configure el modo de la trayectoria. En la figurA precedente se configura a absoluto porque
los datos se están exhibiendo en un panel de proceso del cliente en una computadora
(paroikos) y se origina de un proceso del servidor en una computadora diferente (tripper).

7. Seleccione el miembro de datos que usted desea exhibir en la lista Contents.

8. Haga clic en Paste y después OK.

LookoutDirect responde presentando el cuadro de diálogo Display Numeric Signal o Display
Logical Signal. El tipo de cuadro de diálogo depende del tipo de miembro de datos que es
insertado (numérico o lógico). En este caso la señal es numérica, una onda de coseno generada
por el objeto Waveform 

Seleccione los parámetros de exhibición que usted desea, y haga clic en OK.

Usted puede también arrastrar un objeto del explorador de objetos a un panel. Cuando usted lo
hace, aparece el cuadro de diálogo Insert expression, y usted puede proceder como usted lo hizo
cuando usted invocó este cuadro de diálogo del menú.
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